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Menu Commands
Menu commands are a group of wcCode programs that are provided with Wildcat! and are ready to use. Each of 
these commands is a separate program, and provide the basis for the most commonly used functions of a Wildcat!
BBS.



Topics
These topics will guide you step-by-step through the process of creating a menu structure.
Planning your menu 
Security issues
Access Profiles
Modifying default menus
wcCode   programs  
What if I don’t like my changes?
A typical menu
How do I…



 This lets your callers access the menu using a "Fast Logon" key, bypassing bulletins and menus. Select a key 
from the drop down box.



Command Type
The type of command to execute. There are two options    GoTo Menu and Run wcCode program.
Goto Menu -    Link a menu to this command by selecting GoTo. An edit window containing available menus will 

appear. Select the menu to link to this command.
Run wcCode program -    A list of all the wcCode programs available appears. Select the wcCode program to link 

to this command.    
Command Reference 



 Optional parameters to be executed by the program.



Edit Menu Item
The Edit Menu Item command allows you to change all of the options in a menu item. You can totally customize 
the way each menu item looks. 



Click OK to confirm your changes to this screen and return to the previous window.



Click Cancel to discard your changes to this screen and return to the previous window.



Set security levels to make this command available only to specific security profiles.



Link a menu to this command by selecting GoTo. An edit window containing available menus will appear. Select 
the menu to link to this command.



Select the wcCode program to link to this command.



Command Reference
These are wcCode programs that are included with Wildcat! The most commonly used programs have been 
included, so that you do not have to create them. Of course, you can use wcCode to create new programs and 
add them to the menus. wcCode programs included with Wildcat! are:
Ansi File Area Lister 
Broadcast message 
Bulletin menu 
Change help level 
Change user settings 
Chat between nodes 
Check for mail 
Comment to sysop 
Delete a message 
Display help file 
Display newsletter 
Display text file 
Door menu 
Download files 
Download QWK mail 
Edit marked list 
Enter a message 
Erase activity log 
Info on a file 
Join conference 
List files 
List new files 
List users 
Log off 
Menu 
navterm 
Page another user 
Page sysop 
Personal file stats 
ques 
Questionnaire menu 
Read messages 
Run a door 
Scan messages 
Search file list 
Search for users 
Show Hello screens 
Sysop file editor 
Sysop node management 
Sysop status 
Sysop user editor 
System statistics 
Update scanned confs 
Upload a file 
Upload REP packet 
View a file 
View activity log 



Who is online 



Ansi File Area Lister

Parameters: None.
Lists all the file areas in a scrollable ANSI screen.



Broadcast message

Parameters: None.
Sends an “instant message” to all users currently on line. 



Bulletin menu

Parameters: None.
Displays BULLETIN.BBS, the bulletin menu. 



Change help level

Parameters: None.
Changes prompt detail level to Novice, Regular or Experts



Change user settings

Parameters: “O” for offline mail settings.
Allows callers to edit their own user information. 



Chat between nodes

Parameters: None.
Allows callers to enter live chat and type to other callers. 



Check for mail

Parameters: None.
Scans conferences for new unread mail. 



Comment to sysop

Parameters: “Y” to bypass “Do you wish to leave a comment” prompt. 
Sends a message to the system operator or conference sysop.



Delete a message

Parameters: None.
Deletes the specified message in the current conference. 



Display help file

Parameters: path/filename
Displays help file associated with menu selection. 



Display newsletter

Parameters: None.
Displays NEWSLETR.BBS, if it exists. 



Display text file

Parameters: path/filename
Displays the specified text file



Door menu

Parameters: None.
Displays the Door Menu



Download files

Parameters: file name, file area
Select files to download



Download QWK mail

Parameters: None.
Creates a QWK offline mail packet, and download the packet. 



Edit marked list

Parameters: None.
Displays list of files marked for download, with editing commands. 



Enter a message

Parameters: None.
Create a new message in the specified conference. 



Erase activity log

Parameters: None.
Deletes the activity log for the specified node. 



Info on a file

Parameters: None. 
Displays full file record information on the specified file.



Join conference

Parameters: None. 
Changes the caller’s current conference to the specified conference.



List files

Parameters: None. 
List files available for download in the specified file areas.



List new files

Parameters: file area number
List files available for dowload that are newer than the last “new files” date or the specified date.



List users

Parameters: None. 
Lists name and location of all users on the BBS.



Log off

Parameters: None. 
Logs off (disconnects) the caller from the BBS.



Menu

Parameters: None. 
Displays the main menu



navterm

Parameters: None. 
Starts Navigator Terminal client.



Page another user

Parameters: None. 
Allows caller to send an instant message to another caller.



Page sysop

Parameters: None.
Requests a chat with the Sysop. 



Personal file stats

Parameters: None. 
Displays the caller’s upload and download statistics.



ques

Parameters: path/questionnaire.dat
Runs the specified questionnaire.



Questionnaire menu

Parameters: None. 
Displays QUESTION.BBS, the questionnaire menu.



Read messages

Parameters: A (All conferences) 
I (Inbox)
S (Selected)
* (Snoop)

Read messages in current conference, selected conference or all conferences.



Run a door

Parameters: door batch file name
Runs the specified door batch file.



Scan messages

Parameters: A (All conferences) 
I (Inbox)
S (Selected)
* (Snoop)

Like “Read Messages”, but displays message header instead of full message.



Search file list

Parameters: None. 
Finds files matching search text in name or description.



Search for users

Parameters: None. 
Finds user names matching search text.



Show Hello screens

Parameters: None. 
Reisplays HELLO1 through HELLO9 screens.



Sysop file editor

Parameters: None. 
Displays full file database records for viewing or editing.



Sysop node management

Parameters: None. 
View and edit node settings.



Sysop status

Parameters: None. 
Displays current system status, drive space, database information.



Sysop user editor

Parameters: None. 
Displays full user database records for viewing or editing.



System statistics

Parameters: None. 
Displays SYSSTAT.BBS or system-generated statistics screen. 



Update scanned confs

Parameters: None. 
Allows caller to select favorite conferences for message reading or downloading.



Upload a file

Parameters: None. 
Allows caller to send (upload) files to your BBS.



Upload REP packet

Parameters: None. 
Allows caller to send (upload) QWK mail replies for posting on the BBS.



View a file

Parameters: None. 
Lists the contents of a compressed file.



View activity log

Parameters: None. 
Displays the system activity log.



Who is online

Parameters: None. 
Lists all active nodes, with current caller and activity.



An Overview of wcMenu
wcMenu allows the sysop to customize the menu layout of a Wildcat! BBS. It is composed of two edit windows, a 
menu bar, and a toolbar. wcMenu opens onto a default BBS menu, named Wildcat.mnu. Wildcat! allows only one 
main menu per language, so any changes you make to your menu will overwrite the old one. 
If you accidentally delete the wildcat.mnu file, the next time wcServer is started and doesn’t find the    .mnu file, it 
will create it.
It is important to plan your menu structure beforehand. This will allow you to set up your menus logically and 
easily.



The Edit Windows
Tree Command - This section of the wcMenu screen provides a visual display of the menu tree. 
Listview Command - This edit menu provides a visual display of menu items defined for each menu. To view the 
associated items, highlight the desired menu in the Tree Command edit window. All menu items associated with 
that menu will be displayed automatically.



Before You Begin - Planning a Menu Structure
You may find it useful to define your menu on paper or on your screen using a flow chart tool, so that you can 
easily see the relationship between menus. 

Organization
When you create custom menus for your BBS, you would normally want to make it easy for your callers to find the 
command they want. On a private system where callers will only be dialing in to send or receive a file, it would be 
reasonable to create a single main menu with commands such as upload, list and download. 

Likewise, on a BBS which serves mainly as a network e-mail gateway, a single menu with read and enter 
message commands would be logical, and easy for your callers to navigate. 

A BBS for a PC user group, on the other hand, might have submenus from which a caller can view a schedule of 
upcoming club events, or automatically download a membership application and a selection of useful shareware 
utilities, plus a command for an order-entry questionnaire that will accept credit card payments to renew a caller’s 
membership in the user group.

wcCode programs
You can add wcCode programs to your menus, either as new commands, or to replace internal commands. You 
do not need to own wcCode to run wcCode applications on your BBS - just a WCX application compiled for your 
version of Wildcat!. 

To add a wcCode program to any menu item, highlight the menu you want to edit, then move the cursor to the 
listview edit window. Click the right mouse button and select ADD, or select Edit/Add from the command menu.

Security
It’s important to understand that in order for a caller to be able to see and execute a menu command, you have to 
set access to the commands and the menus. You assign access for menus and menu items in wcMenu.

Access for menu commands is not global - that is, if a security profile has access to the join conference command,
for instance, callers with that security profile will not necessarily have access to the command in every menu in 
which it appears, unless security access is granted for that menu item.

You can define multiple root menus that branch to different sub-menus, depending on security profile. Wildcat! will 
place a caller in the first root menu his security profile has access to.

Tips and traps
You can make menu changes with Wildcat! running but you cannot delete a menu option until the entire system is 
down.

Each menu can have no more than 40 commands, so that Wildcat! can dynamically display all the commands on 
the screen. If you need more than 40 items on a menu, it’s time to consider the complexity and organization of 
what you need to do. Too many choices can confuse a caller.
Even though menus may have the same names, you risk confusing yourself and your callers. If you clone a menu 
to assign security-specific options, give the cloned menu a different name, substructure, or distinguishing feature. 

Stacked commands provide single-keystroke convenience for frequently used selections. For instance, you can 
create a stacked command to Read Unread personal in All conferences, or force comments to the Sysop to 
conference 0 by replacing the internal Comments command with a stacked command to Join 0, then execute the 
Comments command. 



Deleting a menu
To delete a menu, highlight the menu to be deleted, click the right mouse button, and select delete, or use the 
menu command Edit/Delete. You can also press the DEL key. If there is more than one instance of the menu, the 
copy of the menu that is highlighted will be deleted. If you are deleting the primary instance of the menu, you will 
be prompted for confirmation before the menu is deleted.



Deleting a menu item
To delete an item from a menu, highlight the item to be deleted, click the right mouse button, and select delete, or 
use the menu command Edit/Delete. You can also press the DEL key. You will be prompted for confirmation 
before the item is deleted from the menu. If you delete a menu item in a specific menu, the item is not 
automatically be deleted in subsequent menus.



Access Profiles
Security profiles registered by Wildcat! are listed here. This dialog box allows you to set the security level for 
access to menus and menu items.



Marks (highlights) all access profiles. These can then be enabled/disabled.



Unmarks (removes the highlighting) from all access profiles.



Toggles the selected access profile on and off. For example, it New User is toggled on a + (plus sign) will 
appear beside it and it will be active for that menu or menu item. If the access is highlighted and the Toggle 
button is pressed, the New User access will be disabled, and no plus sign will appear.



Select the type of display to be used by the menu from the dropdown list. 



 Select the template for the new menu to use from the dropdown list.



Click the Access button to select the security profile for the menu. Note that even the sysop does not have 
access unless it is given here.



The security level of the group should be carefully considered. Each menu and file group has its own security 
options. Click on the Access button to set the security level. 



 This is a graphic, visual representation of the menus and how they relate to each other. You can drag existing 
menus to another location to change the structure of the tree, or add new menus and submenus.



 This section of the wcMenu screen is a list of all commands in each menu, and the key that the user presses to 
activate them. You can add and edit menu items to each menu and submenu.



Modifying the default menus
If you installed the menus and sample configuration during the initial installation of Wildcat!, the installation 
program for Wildcat! will have copied a definition file of standard, tree-structured menus to your LANGUAGE 
directory. This is the menu file Wildcat! uses to determine which commands and menus are available to each 
security profile, and which menu display files, if any, to show to callers.
It’s important to remember the relationship between the internally-generated or “dynamic “ menus you create with 
wcMenu, and the optional menu display files you create with wcDraw. Changes made to one must also be made to
the other, if your changes are to have any effect. 
This means that if, for instance, you want to add a menu hook to the main menu that launches a database 
program, and you use menu display files instead of Wildcat!’s dynamic menus, you must add the command to your
internal menu definition with wcMenu, and to your menu display files with wcDraw. If you modify only the display 
files, Wildcat! has no command to associate with your new menu selection. If you modify only the internal menu 
definition, your callers will never see the new menu selection on the menu display file. 



Using wcMenu
Always run wcMenu from your Wildcat! home directory. If you have no other languages defined in wcConfig, 
wcMenu will display the following screen. Otherwise it will prompt you to select the language to edit.
Notice the lines linking each menu. The main menu is at the top of the screen. This is where a caller first comes 
into the BBS. 
You can have many more levels if you want. The first level, linked directly to the Main menu, contains the 
Message, File and Sysop menus. Below them, are second level menus, and so on.



 Confirms your selections and continue editing items in this window.



Discards your selections and close the current window



Copies the current selection to the Windows clipboard. Note that anything you copy to the clipboard will replace
the current clipboard contents.



Copies the selected text to the clipboard, and deletes the text from the document. Note that anything you copy 
to the clipboard will replace the current clipboard contents.



Clears the window and opens a new, untitled file for input and editing. 



Confirms your selections and close the current window.



Opens a dialog box prompting you for the drive, path and name of the file you wish to open for viewing or 
editing. You will be prompted to save any changes to the previous file you were working on before the old file is 
closed.



 Copies the contents of the clipboard to the document, at the cursor location.



 Pops up the Print Dialog Box, allowing the text or graphics in the current window to be printed.



Shows a mock-up of the menu as it would appear on your printer. The menu title is at the top of the page, with 
menu keys, descriptions, commands and parameters listed in the order in which they will appear on the actual 
menu. Press the left mouse button to enlarge the preview on your screen.



Pops up the Print Setup dialog box, allowing you to select and configure your printer before printing text or 
graphics.



Restores the results of the last editing command removed with the Undo command. It "undoes" an "undo".



Writes the current file to disk, overwriting the original version of the file. To rename the file without overwriting 
the original, use the Save As command.



Prompts you to enter a name, path and drive to save your text file. Use this command to create a new copy of 
an existing file without overwriting the original.



Process all of the items in this list.



Removes the results of the last editing command you executed. For instance, if you cut or cleared a block of 
text, the Undo command will restore the text to its original place in the document.



Exit the program. You will be prompted to save changes.



When to use wcMenu
wcMenu lets you customize the menu layout of a Wildcat! BBS. It is composed of two edit windows, a menu bar, 
and a toolbar. wcMenu opens onto a default BBS menu, named WILDCAT.MNU. Wildcat! allows only one main 
menu per language, so any changes you make to your menu will overwrite the old one. 
You can create a different menu for each language and each security level.
Use wcMenu when you want to:
· add a new menu.
· change an existing menu.
· add items to your menu.
· change the security access of a menu.
· delete a menu.



Opening wcMenu
From the Wildcat! home directory (normally C:\WC5), type:
WCMENU [ENTER]
or click on the wcMenu shortcut, if you have created one.
Select the language you want to use. The program will open, and you’re ready to start creating and editing menus.
The default Wildcat! 5 menu is located in the default language directory. 



Creating a menu tree

To create a menu tree, from the Tree Command menu:
1.      Select Edit/Add from the command menu or click the right mouse button and select Add. An Edit Menu 

dialog box appears, and you can create a new menu.
2.      Once your menu is created, select the new menu in the Tree Command edit window and move the cursor to 

the list view control box.
3.        Select Edit/Add or click the right mouse button and select Add. An Edit Menu Item dialog box pops up. 
4.      Choose a Selection Key from the drop down list, and type a description of the item, which is how it will 

appear to the user. 
5.      Select a Command Type and a Program.    Type any parameters into the parameters textbox. 
6.      To set the Access level for the menu item, click the Access button and make your selection. 
7.      Choose OK to accept or Cancel to cancel your item.    Repeat this process for each item you want in your 

menu.



Adding a new menu
You may want to add completely new menus to your menu structure. These can be special menus for certain 
callers. For instance, if you are running a company-based BBS, you may want each department to have its own 
menu.
You may want to give particular callers access to special menus relating to their hobbies or interests. The 
possibilities are endless. To add a new menu, 
1.      Place your cursor in the menu tree control box.
2.      Click the right mouse button and select Add, or select the Edit/Add command from the main menu. You can 

also use the [INS] key to add a menu. An Edit Menu dialog box appears. 
3.      Type a description of your new menu in the Description section. 
4.      Select a display name. This is what the caller will see. 
5.      Choose a template, if you want your new menu based on an existing one. 
6.      Click Access and set security access for the menu. When you are satisfied with the information, click OK.



Adding items to a menu
Each menu is composed of individual items. If you have created a new menu without using a template, you will 
have to add each menu item individually. If you have created a new menu based on a template, you may only 
want to modify a few items.
To add new items to a menu: 
1.      Select the menu you want to add the item to and place the cursor in the list view control box. 
2.      Click the right mouse and select Add, select Edit/Add from the command menu, or press the h key. An Edit 

Menu Item dialog box will appear. 
3.      Choose a Selection Key from the drop down list. 
4.      Type a description of the item. This is how it will appear to the user. 
5.      Select a Command Type ( Run wcCode program or GoTo Menu) and a Program. 

6.      Type any required parameters into the parameters textbox. You can use long file names in the parameters, but 
the entire path and filename must be in quotation marks

7.      Set the security access level for the menu item by clicking Access and selecting the appropriate access for 
the menu item. Choose OK to accept or Cancel to cancel your item.



Adding door hooks to the menu
To add doors and menu hooks to your menus, you first need to add them to wcConfig from the Doors and Menu 
Hooks sections. Doors add themselves to the door menu automatically, but you must add menu hooks to the 
menus from wcMenu. 
To add a menu hook: 
1.      Start wcMenu and select the menu on which you’d like to add the hook. The menu items will appear on the 

right-hand side of the screen.
2.      Place the cursor on the menu, at the point you want the menu hook to appear. Press [ENTER]    to pop up the

edit menu item screen. 
3.      Click the down arrow to display the selection keys, and select the one you want for the menu hook. Type the 

description the way you want it to appear in the menu.
4.      Your next option is Command Type. Click the down arrow to see a selection list. Select GoTo Menu.
5.      Click the down arrow (under Program) to select the Menu you want to hook in to. Use the PgUp and PgDn 

keys to move around the selection list. 
6.      Type any parameters to the parameters section. Click the Access button to set the security access for the 

menu item.
7.      Click OK to save your new menu hook command.



Copying an existing item to another menu
You may want to have the same menu item on several menus. There are two steps to copying an item from one 
menu to another: 
· Select the item to be moved. 
· Drag it to the new location. 
The original can then be deleted or left as-is. 
You can create separate menus for different security settings. Menus are independent and may be duplicated 
under different headings. For example, you can have the File Menu active under several primary headings, 
allowing different security access to each.



Deleting menus and    menu items
To delete an item from a menu: 
1.      Select the item to be deleted. 
2.      Click the right mouse button, and select Delete, or use the menu command Edit/Delete. You can also press 

the [DEL]key. 
3.      You will be prompted for confirmation before the item is deleted from the menu. 
If you delete a menu item in a specific menu, the item is not automatically be deleted in subsequent menus.

To delete a menu: 
1.      Select the menu to be deleted. 
2.      Click the right mouse button, and select delete, or use the menu command Edit/Delete. You can also press 

the [DEL] key. 
3.      If there is more than one instance of the menu, the copy of the menu that is selected will be deleted. 
If you are deleting the primary instance of the menu, you will be prompted for confirmation before the menu is 
deleted.



Changing the selection key
Let’s say you want to change the wording of the main menu command Page the Sysop to Yell for the Sysop, 
and you want to change the command letter from P for Page to Y for Yell. 
1.      Move the highlight bar to this line. 
2.      Double click on the key you want to change, in this case, P. The Edit Menu Item dialog box pops up. 
3.      Choose a new Selection Key of Y for the Yell... command.
4.      Type the description you want the user to see. 
5.      Save your work by clicking OK.

If the selection key you want has already been used, wcMenu will pop up a message.
You can change the selection using the selection key to a different one, or select a different one for your new 
menu item.



Changing the Command Order
You can rearrange the order of commands on your menu by selecting and moving individual commands. 
To move a command, select it and drag it to the new location. 
You can also use the Edit/Sort command to sort menu items.



Linking a menu to the tree
When you create a new menu, it is automatically added at the bottom of the Menu Tree. To change the branch, 
make it a sub-menu or a sub-sub-menu, 
1.      Select the menu to be moved and drag it to the desired location. 
2.      An Edit Menu Item dialog box will appear, with Description, Command Type and Menu filled in. 
3.      Choose the selection key the user will use to jump to the new menu and set security access for the menu.
4.      When you are satisfied that the information about your menu is the way you want it, click OK.



Creating multiple menu trees
Menus are created by selecting the Edit/Add command from the main menu or clicking the right mouse button 
when the cursor is in the Menu Tree control box. Once you have created your menus, add the items you want to 
each menu. 
When all items have been added, you can drag the menus into the tree order you want using the Tree Command 
Menu edit window area. If you want a menu to be a submenu of another, grab the menu and drag it into the 
desired primary menu.



wcCode programs
You can add wcCode programs to your menus, either as new commands, or to replace internal commands. You 
do not need to own wcCode to run wcCode applications on your BBS    just a WCX application compiled for your 
version of Wildcat!. 

To add a wcCode program to any menu item, 

1.      Select the menu you want to edit, then move the cursor to the list view edit window. 

2.      Click the right mouse button and select Add, or select Edit/Add from the command menu.

3.      Fill in the Selection Key and Description fields in the Edit Menu Item window. For Command type, select 
Run wcCode program. If you have created your own wcCode program, it will appear in the drop down box for
Programs. 

4.      Click the down arrow at the right of the text box to see a list of available wcCode programs. 

5.      In Parameters, type the command line arguments you want to pass to the application. 

6.      Click Access to set the security access for this item. 

7.      Click OK to save your new menu command, and exit wcMenu.



Security
It’s important to understand that in order for a caller to be able to see and execute a menu command, you have to 
set access to the commands and the menus. You assign security access for menus and menu items in wcMenu.

When creating new menus or updating existing ones, be sure to select Access, and set the access profile(s) that 
you want to have access to the menu item, as well as the menu itself.

To select the access profile(s) that you want to have access to the menus and menu items,

1.      Click Access in the Edit Menu (Item) dialog box.

2.      Click on an access profile to select it, or 

3.      Choose the Select All command to select all    access profiles.

If you have many access profiles, and want to select at least one, but not all, you can mark the securities to be
given access and then click on Toggle.

You can also Unselect all, if you want to remove all access profiles from this item or menu. 

NOTE: Be careful. If you unselect all and do not re-select your own access profile, you won’t be 
allowed access to this menu or item, either!

4.      When you are satisfied with your selections, click OK.

You can define multiple menus that branch to different sub-menus, depending on access profile. Wildcat! will place
a caller in the first menu that his access profile has access to.



What if I don't like my changes?
If you don’t like the changes you have made to a menu, select File/Open. You will be asked if you want to save 
the changes you have made. Say No. 
Your changes will be discarded. If you want to edit the menu again, just re-open it.



Some tips about menus
Each menu can have no more than 40 commands, so that Wildcat! can dynamically display all the commands on 
the screen. If you need more than 40 items on a menu, it’s time to consider the complexity and organization of 
what you need to do. Too many choices can confuse a caller.
Even though menus may have the same names, you risk confusing yourself and your callers. If you clone a menu 
to assign security-specific options, give the cloned menu a new and completely different name, substructure, or 
distinguishing feature. 
In most instances, you will want to be sure to include a key selection that allows your callers to return to the main 
menu.
Don’t forget, when using long file names, the entire path and filename must be in quotation marks.



How do I...
Opening   wcMenu   
Creating a menu tree
Adding a new menu
Adding items to a menu
Adding door hooks to a menu
Copying an existing item to another menu
Deleting an existing menu item
Changing the selection key
Deleting a menu
Changing the Command Order
Linking a menu to the tree
Creating multiple menu trees



Lets you set the security profile for the menu.



 Opens the access profiles dialog box, allowing you to select the security profiles that have access to this menu.



 This is the description for the menu command, as it will appear on the user’s screen. 



 The name of the custom menu file that replaces the dynamic menus.



Opens the access profiles dialog box, allowing you to select the security profiles that have access to this menu 
item.



 This is the command to execute when the user selects this menu item. There are two options: Run wcCode 
program, and Goto Menu. 
To change to another menu, select Goto Menu, and select the destination menu in the Parameters window.
To execute a wcCode program, select wcCode program, then choose the name of the program to execute from 
the selection list.



This is the description for the menu command, as it will appear on the user’s screen. 



 Link a menu to this command by selecting GoTo. An edit window containing available menus will appear. Select 
the menu to link to this command.



The command option to execute. 



The name of the wcCode program or menu to execute. An edit window will appear, allowing you to select from 
available wcCode programs or menus available.



 An edit window will appear displaying all available wcCode programs. Select the wcCode program to link to this 
command.



    Drops down a list of available keys. If you select a key that is already associated with a command, you will be 
notified and prompted to select another. This key is the letter the user presses to execute the menu command.



 All of the fast login characters already defined are displayed. To edit an entry, double click on it.



 Select the language for this menu. Each language has its won subdirectory.



A typical menu
A typical Wildcat! BBS has a Main Menu, with branches to the Message Menu, File Menu and Sysop Menu. 
There are two parts to creating a menu. The first part is required; the second part is completely optional.
1.      Define the structure with the Menus tool in the Wildcat! Control Panel (wcMenu): 

Menu names
A menu name contains a list of menu commands.
Commands on each menu
Select the commands to appear on each menu.
Links to other menus
Allow callers to jump to other menus.
Security access to menus
Control access to menus and commands with access profiles.

2.      Define the appearance by creating menu display files with the ANSI Dra (wcDraw) tool in the Wildcat! Control 
Panel. You can create different menu display files for:

Languages
Each language can have its own set of menu files.
Menus
Each menu can have its own screen: Main, Sysop, File, Message, and so on.
Access level
Each access profile can have its own complete set of menu display files: Sysop, Newuser, Fulluser, and 
so on 
Conference
Each conference can have its own set of menus

The menu structure is stored in a data file called WILDCAT.MNU. The menu data file is stored in a data file in the 
LANGUAGE subdirectory. 
The menu display files are stored in the MENU directory. Each conference can have its own MENU directory. Each
language can also have its own MENU directory. 

Automatically generated menus
If an ANSI menu is not created or available, Wildcat! automatically creates and displays a dynamic menu, showing
only the commands a caller can access. 
Wildcat! creates the dynamic menus from the text you define with the Menus tool in the Wildcat! Control Panel 
(wcMenu). 

Custom display file menus
You can replace the automatically-generated menus with display files, with your own choice of color schemes, 
ASCII graphics, and screen layout. Use ANSI Draw (wcDraw) to view and edit the custom display file menus.
Menus are shown as an expandable/collapsible tree in the left window, with the commands for the currently 
selecting menu in the right window.
The tree view in the left window shows all menus with their link relationships to other menus. You can expand or 
collapse the tree view. Click the + symbol to expand a branch. Click the - symbol to collapse a branch. 




